CHANGING FONTS AND STYLES GLOBALLY

Chapter 10

Changing Fonts,
Styles, and Sizes Globally

Although Apple hired professional designers
to create the card, calendar, and book tem-
plates, iPhoto makes it possible to change
the font, style, and size of text for different
categories of text. Be careful when modify-
ing these defaults, though, because Apple’s
font choices are highly intentional, and if you
change them too much, the results may not
look as elegant as you'd like.

To change fonts, styles, and sizes:

1. When creating a card, calendar, or book,
click the Settings button to show the set-
tings dialog (Figure 10.44, Figure 10.45,
and Figure 10.46). For calendars, click
the Styles button, if necessary.

2. To change the look of different classes
of text, choose from the various pop-up
menus to change the font and style, and
enter new sizes in the size fields.

3. Click OK to apply your changes.
v Tips

B The classes of text often change for
different themes.

B If you muck up the text settings badly,
click Restore Defaults to reset them.

B Using certain Type 1 PostScript fonts
can cause your book order to be can-
celled. For more information, see
http://support.apple.com/kb/TA22924.
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Figure 10.44 Cards have relatively little text, and
thus provide only a few categories you can modify.
Deselect the Include Apple Logo on Back of Card
checkbox if you don’t want to advertise Apple’s role

in making your gorgeous card.
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Figure 10.45 Calendars offer quite a few more cat-
egories of text to modify. Be careful, because some
caption and event text is very small, and not all fonts

work well at small sizes.
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Figure 10.46 Along with a number of categories of
text, books offer the option to include photo titles
and descriptions automatically, and to turn page

numbers on and off.
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Figure 10.47 Select the font, style, and size from
the Family, Typeface, and Size columns in the Fonts
window.

Copying Font and
Style Information

If you've set the font, style, and size for
one piece of text, you can copy that to any
other bit of selected text easily.

1. Select the text whose settings you
want to use elsewhere.

2. Choose Copy Style ((Cmd](Option)C))

from the Edit menu’s Font submenu.

3. Select the text whose settings you
want change.

4. Choose Paste Style ((Cmd]Option)(V])
from the Edit menu’s Font submenu.

iPhoto changes the currently selected
text to match the font, style, and size
of your original selection.

Changing Fonts, Styles,
and Sizes per Text Box

iPhoto also provides several ways to modify
the font, style, and size of selected text.

To change fonts, styles, and sizes:
1. Select the text you want to change.

2. Open the Fonts window by choosing
Show Fonts ((Cmd)T)) from the Edit

menu’s Font submenu.

3. Inthe Fonts window, you can choose a
font from the Family column, a style from
the Typeface column, and a size from the
Size column (Figure 10.47).
iPhoto changes the currently selected
text to match your choices.

To change just styles:

¢ Select some text, and from the Edit
menu's Font submenu, choose Bold

([cmd]B)) or Italic.
¢ (Control]-click the selected text, and choose

Bold, Italic, Underline, or Outline from
the contextual Font submenu.

v Tips

B Bold and Italic are dimmed in the menus
if the current font has no Bold or Italic
typeface. Verify in the Fonts window.

m iPhoto does not provide keyboard short-
cuts for Italic, Underline, or Outline.

B The Restore Defaults button in the set-
tings dialog also overrides any individual
font changes you've made.

B Bejudicious in your changes: excessive
use of fonts and styles generally looks
lousy, and [ strongly encourage you to
print a page or two on your own printer
before buying a card, calendar, or book
whose fonts you've changed.

192

181

X0g 1X3] ¥3d SITALS ANV SLNO4{ DONIDONVH)



CHANGING TEXT COLOR

Chapter 10

Changing Text Color

Although it’s not obvious, iPhoto provides
controls to change the color of text as well.

To change colors:
1. To open the Colors window, [Control)-click

a text box and choose Show Colors from
the Font submenu (Figure 10.48).

or
In the Fonts window, click the text color
button.

iPhoto opens the Colors window
(Figure 10.49).

2. Select the text to which you want to
apply a color, and click a color in the color
wheel.

iPhoto changes the color of the text.
v’ Tips

B You can apply color only to selected
text, not to classes of text in the settings
dialog.

B To copy a color from elsewhere on the
screen to the color box, click the mag-
nifying glass icon, and then click a color
anywhere on the screen.

B Drag the color box to one of the cells of
the color swatch collection to save it for
repeated use. Clicking one of the color
swatches applies it to the selected text.

Copying fonts also copies colors.

Use color carefully and sparingly—it’s too
easy to make a book garish by applying
too much color. You don’t want your text
to compete with your photos.
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Figure 10.48 To open the Colors window, Control-click
a text box, and from the Font submenu, choose Show
Colors.
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Figure 10.49 Click a color in the color wheel to put it
in the color box and apply it to the selected text.
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7

Figure 10.50 Note how iPhoto has underlined the mis-
spelled words in red.
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Search in Google Figure 10.51 To
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Cut spelled word
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Weiting Direction.  * | 5 guess from the

e > | contextual menu.

Talking Captions

For longer spans of text, select all the text
((Cmd](A)), (Control]-click it, and from the
Speech submenu, choose Start Speaking.
iPhoto will read your text to you, which
can help identify mistakes.

Checking Spelling
as You Type

You won't be typing much in iPhoto, but
since its editing environment is crude,
typos are likely. The last thing you want in a
beautifully designed card, calendar, or book
is a glaring typo, so I recommend you use
Mac OS X’s built-in spell checker to verify
the spelling of your titles and captions as
you type them.

To check spelling as you type:

1. Click a text box, and from the Edit menu’s
Spelling submenu, verify that Check
Spelling While Typing has a checkmark
next toit.

2. Type your text in any text box.
iPhoto displays a red line underneath any
words that aren’t in the system-wide Mac
OS X spelling dictionary (Figure 10.50).

3. (Control}-click a word with a red underline
to display a contextual menu that enables
you to replace the word with one of Mac
0S8 X's guesses, ignore the misspelling for
this launch of iPhoto, or learn the spelling
by adding it to your system-wide Mac
OS X dictionary (Figure 10.51).

v Tips

B Check Spelling While Typing is on by
default and stays on all the time.

m Ifyou quit iPhoto and come back to
a book later, you must check spelling
manually to find errors in existing bits
of text. To do this, click in each text box
and choose Check Spelling from the Edit
menu’s Spelling submenu ((Cmd)(;)). I

recommend using the keyboard shortcut.

B Ignore Spelling isn’t particularly worth-
while—iPhoto forgets ignored text
between launches.
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PRINTING ON YOUR OWN PRINTER

Chapter 10

Printing on
Your Own Printer

iPhoto makes it easy to print a card, calendar,
or book on your own printer, which is faster
than waiting for Apple to deliver the finished
product, though books and calendars lack
bindings, of course.

To print on your own printer:

1. While in a card, calendar, or book, choose
Print from the File menu ((Cmd]P]).
iPhoto displays the standard Print dialog
(Figure 10.52).

2. Select the options you want (switch
among sets of options using the pop-up
menu under the page range fields).

3. Click the Print button.
v Tips

B You can print individual pages from a
book layout to mix photos and text on a
single page in ways beyond print projects.

W [ also particularly like printing the date
pages from calendars for posting in
schools or other organizations.

W It's difficult to print cards, since you need
to print one page, wait for the ink to dry,
and then flip the paper and print the
second page on the other side, and the
two sides may not match up. Test before
assuming it will work!

B Choose Open PDF in Preview from the
PDF pop-up menu to see what your out-
put will look like before printing. I recom-
mend that you do this, especially since it
simplifies printing only selected pages.

m Choose Save As PDF from the PDF pop-
up menu to generate a PDF instead of
printing. It's a nice way to share a photo
layout with friends via email.

Figure 10.52 To print a book on your own printer,
choose Print from the File menu.

Printing Selected Pages

If you want to print just a few pages in
your book, you may find it difficult to
figure out exactly which page numbers to
enter into the Print dialog. That's because
iPhoto doesn't assign a page number to
the cover, and the inside cover is never
printed. Follow these steps for a more
obvious approach:

1. Choose Print from the File menu
((€md)(P)) to bring up the Print dialog.

2. Choose Open PDF in Preview from
the PDF pop-up menu to make iPhoto
create a PDF and automatically open it
in Apple’s Preview application.

3. In Preview, review exactly which pages
you want to print, paying attention to
the page numbers in the page drawer.

4. In Preview, choose Print from the File
menu and enter the appropriate page
numbers in the Pages fields. Set any
other printing options you want, such
as number of copies or print quality.

5. Click Print to send your pages to the
printer.
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Incomplete Book
| Your book seems to have frames on one or more
r pages that do not contain photos. You must either

change the layout of those pages or place photos in
those frames before you can buy this book.
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Figure 10.53 If you haven’t finished placing photos on
your pages, iPhoto warns you with a dialog like this.
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Figure 10.54 Convey the details of your order to Apple
in the Order window.

Pricing and Shipping Details

Prices vary by style, size, and number of
pages; read Apple’s pricing page at www.
apple.com/ilife/iphoto/prints.html
for details.

Shipping costs vary by the number of
items you order and the type of item, but
note that per-item shipping costs are less
for subsequent items (in other words, if
you buy two copies of a book, you'll pay
only a little more to receive the second
one, instead of double the normal ship-
ping charge).

Ordering Cards,
Calendars, and Books

Once you've designed a card, calendar, or
book, ordering it from Apple is easy.

To order a card, calendar, or book:

1.

2.

Select the item you want to order, and
verify that each page looks right.

Make sure you're connected to the
Internet, and click the Buy button.

iPhoto assembles the print job, warning
you if some photos won't print well, if
some default text hasn’t been edited, if
other text doesn't fit, or if a book or calen-
dar isn't complete (Figure 10.53).

iPhoto then opens the Order window
(Figure 10.54).

Enter the number of items you want to
order in the Quantity field.

iPhoto automatically updates the total
cost as you add and subtract items.

Choose the appropriate shipping address
and method from the Ship To and Ship
Via pop-up menus.

Click the Buy Now button.

iPhoto uploads your pictures and alerts
you when it's done.

v Tips

Hardcover books now have photo-
wrapped covers and matching dust
jackets, so you can’t choose cover color.

Uploading can takes a long time because
iPhoto uploads full-size images.

If you're warned about low-resolution
images, see “Dealing with Warning Icons,”
on page 177.

If this is your first order, review the Apple
1D setup details on pages 164-165.
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TROUBLESHOOTING

The Trouble with Bugs

Many iPhoto problems that I've seen
people report seem to be specific to their
photos, a particular iPhoto Library, their
Mac, or the phase of the moon, and I have
been unable to reproduce them. I still
include here the potential problem and
any solutions I've heard of or can think of,
but this uncertainty makes it impossible
for me to say when or if Apple has fixed
the incorrect behavior. As such, some of
the problems and solutions listed in this
chapter may no longer apply to iPhoto '09;
there’s simply no way to tell.

I continue to include these suggestions
even when I can't verify them because
bugs are slippery, and just because I can’t
reproduce a particular problem in this or
any other version of iPhoto doesn’t mean
that you won’t experience it. And then
one of the suggestions in this chapter may
save your bacon (or at least your photos).

Also keep in mind that updates to iPhoto
very well may eliminate even those prob-
lems I've confirmed in iPhoto '09, so be
sure to use Software Update to check for
new versions on a regular basis.

The world of iPhoto is no more a perfect
place than the real world. No one, iPhoto’s
developers least of all, wants problems, but
bugs are a fact of life, and you may have a
problem with iPhoto at some point.

One advantage iPhoto has in this respect

is that it saves your changes frequently and
automatically, so you're unlikely to lose
much work even if it does crash. Put simply,
if iPhoto crashes (and it has crashed on me

a number of times while I was writing this
book). just relaunch the program and pick up
where you left off. Also be sure to click the
Report button in the crash dialog and report
the crash to Apple so it can be fixed. If the
crashes happen regularly, you may need to do
some troubleshooting. One way or another,
keep good backups! (See “Backing up Your
Photos,” on page 26.)

Of course, most of the problems you might
encounter won't result in a crash. It's more
likely you'll have trouble importing photos
from an unusual camera, printing a photo
at the exact size you want, or dealing with
thumbnails that don't display properly.
Those are the sorts of problems—and
solutions—T'll focus on in this chapter.

11
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GENERAL PROBLEMS AND SOLUTIONS

Chapter 11

General Problems
and Solutions

Some problems you may experience in
iPhoto aren’t related to particular activities.
Others are, and subsequent pages in this
chapter will address issues with importing,
editing, slideshows, printing, and more.

Performance Problems

If you find iPhoto slow to perform certain
operations, try these tricks. Some are
obvious (if expensive), others less so:

¢ Turn off title, rating, and keyword display
using the View menu.

@ Shrink thumbnails to a smaller size.

¢ Use the triangles next to events in Photos
view to hide photos you don’t need to see.

¢ Quit other programs that are running.
In my experience, there is usually one
culprit, which you can identify by launch-
ing Activity Monitor from your Utilities
folder and clicking the CPU column title
to see which applications are using the
most processor time.

® Restart your Mac by choosing Restart
from the Apple menu. Restarting is
especially helpful if you don’t have much
free disk space, which cramps Mac OS X's
virtual memory techniques.

¢ Check your disk with DiskWarrior
(www.alsoft.com/DiskWarrior/);
sufficient disk corruption can cause
huge performance problems on startup.

¢ Add more RAM to your Mac. iPhoto
works with 512 MB of RAM, but it likes
a lot more, and RAM is cheap. I always
recommend at least 1 GB these days.

¢ Buy a faster Mac. That’s always fun.

Some Photos Disappear

Some people have reported troubles with
photos disappearing, even when the files are
still present in the iPhoto Library. Try the
following;:

¢ Make sure the photos aren't just in the
Trash; it's easy to delete inadvertently.

¢ Hold down while clicking
the iPhoto icon in the Dock to launch it.
This causes iPhoto to display the Rebuild
Photo Library dialog.

Try each of the options, and see if one of
them fixes the problem. For more info, see
http://support.apple.com/kb/HT2638.

¢ With iPhoto as the frontmost applica-
tion, choose Enter Time Machine from
the Time Machine menu in the menu
bar. Navigate back in time through Time
Machine's backups to the point where
you see the missing photos, then click
the Restore button.

¢ Ifyou have the photo elsewhere on your
Mac or on another computer, just import
it again.

All Photos Disappear

What if none of your photos appear at all?
First, try the options listed just above, and if
they don't help or aren’t possible, try these:

* Make sure you're using the correct iPhoto
library. Locate the one you want in the
Finder and double-click it to open it.

® Create a new iPhoto library and import
the contents of the Originals folder (and,
if desired, the Modified folder) inside
the corrupted iPhoto library package.
(Control-click it and choose Show Package
Contents to get at those folders (see
“iPhoto Directory Structure,” on page 19).
This won't preserve anything but the
photos, unfortunately.
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Troubleshooting

Flaky Behavior or Crashes

Sometimes iPhoto just acts strangely, and
I've come up with a few ways of dealing
with weird behavior (make sure you have
a backup before deleting any files!):

¢ Quit iPhoto and relaunch it.

¢ Restart your Mac by choosing Restart
from the Apple menu.

¢ Quit iPhoto. From the Preferences folder
inside your user’s Library folder, drag the
file com.apple.iPhoto.plist to the Desktop
and launch iPhoto again. Deleting this
file can even resolve missing or truncated
text problems with books, cards, and cal-
endars; for details, see http://support.
apple.com/kb/TS1616.

¢ Hold down while clicking the

iPhoto icon in the Dock to launch it. In
the Rebuild Photo Library dialog, try each
of the options, quitting and relaunching
in between attempts, and see if one of
them fixes the problem. For more info, see
http://support.apple.com/kb/HT2638.

¢ Use iPhoto Library Manager’s Rebuild

Library command, which uses the
AlbumData.xml file written by iPhoto to
re-create the library. This is a completely
different method from what iPhoto uses.
(It's at www. fatcatsoftware.com/iplm/.
iPhoto Library Manager's help has other
useful troubleshooting information too.)

¢ Run Disk Utility and use the buttons in
the First Aid pane to verify and repair
both permissions and the disk.

¢ Delete and re-install iPhoto.

¢ Try creating a new iPhoto library and
re-importing your photos from the
Originals and Modified folders.

Other Problems

Here are a few other general problems and
their solutions:

¢ Don't attempt to read a newer iPhoto
library with an older version of iPhoto,
or corruption could ensue.

¢ IfotheriLife apps can’t see your photos,
or if some photos or albums are missing,
read this support article for things to try:
http://support.apple.com/kb/TS1192.

¢ Ifyou have trouble with iPhoto’s photo
sharing or the sharing tools that upload
data, shut off or bypass your firewall to
see ifit's blocking necessary ports.

¢+ IfiPhoto complains about being unable
to establish a connection when uploading
to MobileMe, make sure the date is set
correctly in the Date & Time preference
pane in System Preferences.

¢ Ifmailing a photo in Apple’s Mail doesn’t
resull in an enclosure, and another user
on the Mac has successfully attached a
photo in the same session, restart the
Mac and try again.

¢+ Ifyou've ended up with duplicate photos,
you can delete them with the $7.95
Duplicate Annihilator from Brattoo
Propaganda Software (waw.brattoo. com/
propaganda/index.php?s=1169727148&a
ction=software). Make a backup before
running this program!

Report Your Problems!

Report any problems you may have by
choosing Provide iPhoto Feedback from
the iPhoto menu and then filling in
Apple’'s Web-based feedback form.
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IMPORTING PROBLEMS AND SOLUTIONS

Chapter 11

Importing Problems
and Solutions

I've had little trouble importing photos into
iPhoto. However, because importing involves
interacting with an unpredictable outside
world of cameras, card readers, and files of
varying formats, problems can occur.

Camera or Card
Reader Isn’t Recognized

Mac OS X and iPhoto support most
common digital cameras and card readers,
but not all of them. And sometimes iPhoto
may not recognize specific memory cards,
even if it recognizes the card reader in
general. Try the following tips:

¢ Make sure the camera is turned on, in
review mode, and plugged in via USB
properly. I know it seems obvious, but
we've all made this mistake before.

¢ Use Software Update, accessible in
System Preferences, to make sure you
have the latest version of Mac OS X, since
Apple continually adds support for more
digital cameras and card readers.

¢ Ifyour camera is incompatible with Mac
0OS X and iPhoto, buy a card reader that
supports the memory card used by your
camera.

¢ Ifyour user account can run only certain
applications, that may prevent you from
importing in iPhoto. The only fix is for
an administrator-level user to increase
the capabilities of your account in the
Accounts and Parental Controls prefer-
ence panes,

¢ Some cameras must be placed in Picture
Transfer Protocol mode to communicate
with iPhoto. And if that doesn’t work, try
other modes. Check the manual for help.

¢ Older versions of iPhoto have had trouble
with some large memory cards. People
have resolved the issue by reformatting
the card in the camera, using a memory
card reader, or using smaller cards.

¢ Tryreformatting the memory card in the
camera and taking a picture before con-
necting it to the Mac again. Keep in mind
this will destroy any photos already on
the card!

¢ Ifyou have two cameras connected at
once, or a camera and a scanner, iPhoto
may become confused about which
device to use. Connect only one device
at a time if this causes trouble for you.

Nothing Appears after Import

If nothing appears in iPhoto after you
import files from your hard drive, try these
solutions:

¢ Instead of using the Import to Library
command in the File menu, drag the
images (or a folder containing them)
onto iPhoto’s display pane.

¢ Like all Mac OS X applications, iPhoto
is sensitive to proper permissions. So, if
you've moved your iPhoto Library and are
trying to import from another user, verify
in the Finder's Get Info window for the
iPhoto Library package and all enclosed
folders that the appropriate user has Read
& Write permissions.

¢ The photos might be duplicates, which
iPhoto imports only if you tell it to do so.
See Chapter 2, “Importing and Managing
Photos,” starting on page 11.

¢ Ifthe files you imported were located in
the iPhoto Library package, iPhoto may
assume they've already been imported
and won't do so again. To solve the
problem, move the files out of the iPhoto
Library package and try again.
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Troubleshooting

Damaged Photos Warning
Appears during Import

Sometimes when you import photos, you
may see an error dialog complaining about
unreadable photos. It can occur for a variety
of reasons:

¢ You're accidentally importing non-
graphic files, such as aliases to photos,
HTML documents, or other data files.

¢ The image files may actually be damaged.
See if you can open them in Preview or
GraphicConverter. If so, you may be able
to convert them to another format and
eliminate the corruption.

¢ Ifyour files are in an unsupported format,
try using GraphicConverter to convert
the images to JPEG. Similarly, if RAW
images from your camera aren’t sup-
ported by iPhoto, see if your camera
manufacturer makes a utility that will
convert them to a supported format.

¢ Sometimes the problem may relate to a
communications failure between your
camera or card reader and your Mac.
Try plugging the camera or card reader
directly into one of the Mac’s USB ports
rather than into the keyboard’s USB port
or a port on a USB hub.

# iPhoto can display the damaged photo
error message if your hard disk is full.
Since iPhoto duplicates every photo when
importing from files, if you're importing
hundreds of megabytes of photos from
files, it'’s by no means unthinkable that
you could run out of disk space. Clear
some space and try importing again.

¢ Photos taken with Apple’s QuickTake
100 and QuickTake 150 digital cameras
must be converted from the special for-
mat Apple used into the JPEG format.

Other Importing Problems

Here are a miscellany of importing problems
and solutions that don't fit larger categories:

¢ iPhoto may crash if you disconnect your
camera while photos are transferring.

¢ [fiPhoto fails to warn you about dupli-
cates, it may be because the date and
time on your camera are wrong.

¢ Make sure there are no aliases among
files you are importing; they can cause
crashes.

¢ iPhoto 2 won't recognize discs burned in
later versions of iPhoto, although the later
versions can recognize older discs.

¢ [fiPhoto complains about not being
able to upgrade your library on the first
launch, the problem may be related either
to incorrect permissions or to locked
files. For instructions on how to solve this
problem, see http://support.apple.com/
kb/T$1318.

¢ Ifyou import a misnamed file—a TIFF
file with a . jpg filename extension, for
example—iPhoto may display the picture
strangely when editing, refuse to let
you order prints, or even crash. Delete
the misnamed picture from your Photo
Library; then rename it appropriately in
the Finder before importing it again.

¢ Ifyou have erased your camera and need
to recover the original photos, check out
the $29 PhotoRescue (a free version will
tell you if it's going to work). Learn more
at waw.datarescue.com/photorescue/.
Also try the $39.95 ImageRecall from
www.flashfixers.com/software/ or
the $29.95 MediaRECOVER from
www.mediarecover.com.

202

191

SNOILNTOS ANY SW3T180dd DNILIOdW|



EDITING PROBLEMS AND SOLUTIONS

Chapter 11

Editing Problems
and Solutions

Most photo editing problems stem from
using another program to edit the photos.

Photos Don’t Open
in an External Program

Although it is unlikely that you'll run into
this problem, it could be frustrating. Here are
a few reasons it could happen:

¢ Ifyou have changed the name of the
photo’s file in the Finder, it may not
open when double-clicked in iPhoto.
The solution? Change the filename back
to what iPhoto expects, and don’t mess
with any filenames within the iPhoto
Library. It's a bad idea!

¢ Double-check to make sure iPhoto’s
preferences are set to open photos in an
external program (see “Using an External
Editor,” on page 110), that the program is
present on your hard drive, and that you
can launch it and open photos normally.

Photos Don’t Appear
When Edited or Magnified

There are a few reasons why iPhoto might
show only a black screen or fuzzy exclama-
tion point when you edit or magnify a photo:

¢ Changing the photo’s filename in the
Finder can cause this problem. Don't
do it!

¢ A corrupted photo can cause iPhoto
to freak out. Editing and saving the
original file in another application might
eliminate the corruption, or you could
delete the corrupt photo and import it
again, assuming you have another copy.

iPhoto Doesn’t Allow Editing

Some people have reported importing
images from a CD that they later couldn’t
edit in iPhoto. As a workaround, convert the
images in GraphicConverter from JPEG to
TIFF, for instance, and see if you can import
and then edit those versions.

Also verify that the permissions on the files
allow your user to write to the files. To check,
select them in the Finder, choose Get Info
from the File menu ((Cmd] 1)), and look in the
Permissions area.

Revert to Original Dimmed

You may see the Revert to Original com-
mand in the File menu dimmed after you've
made a change. This can happen if you drag
a photo from iPhoto to another program to
edit the photo. If you do that, iPhoto will be
unable to track changes you've made and
Revert to Original will be dimmed. There's no
workaround, other than making sure to open
photos for editing in external applications
properly from within iPhoto. See "Using an
External Editor” on page 110.

Thumbnails Are
Corrupted or Cause Crashes

If a thumbnail doesn’t reflect edits, is entirely
black, or causes iPhoto to crash, hold down
while clicking the iPhoto icon

in the Dock to launch it. In the Rebuild
Photo Library dialog, select the first two
checkboxes to rebuild all thumbnails.
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Troubleshooting

RAW File Facts

Apple’s support for RAW files in iPhoto has
caused some confusion. The following facts
may shed some light on it for you:

¢ RAW files are considered to be “digital
negatives” that aren’t to be modified, so
changes you make are always saved to
a secondary file. As a result, on import,
iPhoto converts the RAW file to JPEG and
stores the RAW file itself in the Originals
folder. Alternatively, you can set iPhoto
to save edited RAW files as 16-bit TIFFs.

You never work on the RAW file directly,
only on its JPEG or TIFF stand-in. If you
wish to throw out your edits and start

a new copy from the RAW file again,
choose Reprocess RAW from the Photos
menu.

¢ Because of the large size of uncompressed
RAW files and the JPEG conversion that
occurs during import, the import process
can take a longer time with RAW files.

¢ When you edita RAW file, iPhoto displays
a RAW badge at the bottom of the display
pane or in the toolbar in full screen view.

¢ Scrolling may seem slower when brows-
ing through large thumbnails of RAW
files. The problem is that when you're
using a thumbnail size larger than the
actual thumbnails, iPhoto must load the
original photo to create the thumbnail.
That's a slower process. To speed up
scrolling, press 1 while in organize mode
to zoom to thumbnail size (press 0 to
zoom to the smallest size).

¢ Toexporta RAW file in RAW format,
choose Original from the Format pop-up
menu in the Export Photos dialog.

¢ For more info, see http://support.
apple.com/kb/TA22895.

Slideshow Problems
and Solutions

Slideshows can run into a variety of prob-
lems; try these solutions:

¢ PowerPC G4- and some PowerPC
G5-based Macs don't support all of
iPhoto '09’s slideshow themes. See
http://support.apple.com/kb/TS2576.

# Some transitions, like Cube and Flip, may
not work on older Macs with less capable
video cards.

# Music purchased from the iTunes Store
and used in a slideshow can be heard only
on authorized computers. Either pick
different music or convert tracks (burn to
CD and re-import into iTunes) for use on
other computers.

¢ [fslideshows look wrong, try switching
to “Thousands” of colors in the Displays
pane in System Preferences.

¢ Ifaslideshow takes a long time to start,
it may be because of a very large music
file you've set to play. Pick a smaller file
to speed start time.

¢ Ifslideshow transitions are slower than
you've set, it may be because your photos
are too large or your screen resolution is
too high. Setting a lower resolution in the
Displays preference pane or using smaller
photos should speed transitions.

¢ Ifyoucan’t see youriTunes Library when
selecting music for a slideshow, launch
each of these applications in this order:
iTunes, iPhoto, iMovie, and then iDVD.

¢ If Windows users see error -8992
when trying to play your QuickTime
movie, have them turn off DirectDraw
Acceleration in the Video Settings screen
of the QuickTime Settings control panel.
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PRINTING PROBLEMS AND SOLUTIONS

Chapter 11

Printing Problems
and Solutions

Many printing problems you'll experience
will be specific to your particular printer and
setup, so read your printer manual carefully
and be sure to test before printing at the
highest quality on expensive paper.

Prints Don’t Appear
Correctly on the Paper

You may have trouble getting prints to show
in exactly the right location on the paper. Try
these solutions to the problem:

¢ Set the paper size and print size appro-
priately in the pop-up menus in the print
settings dialog. This is key for unusual
paper sizes.

#® Make sure the margins are set correctly
for your printer and paper combination.

¢ Verify that you load paper into your
printer properly. This solution helps par-
ticularly with unusual paper sizes.

Printing calendars on your own printer may
result in similar problems. Solve the problem
by saving a PDF of the calendar and then
printing from Preview. For more details, see
http://support.apple.com/kb/TS1073.

Photos Print at Incorrect Sizes

Even if you ask iPhoto to print a standard
size print, the image that comes out of the
printer might not be the size you want. This
can happen if you change the layout to print
multiple pages per sheet of paper in the Print
dialog’s settings.

Poor Print Quality

The main complaint with printing occurs
when print quality doesn’t meet your
expectations. Here are a few suggestions
for addressing print quality problems:

¢ Make sure your inkjet cartridges aren’t
clogged. Once my black ink cartridge
clogged and it took me an hour to figure
out that the clog caused color photos to
print oddly. Your printer manual should
tell you how to clear clogs.

¢ Change your ink cartridges. It’s possible
that one is low on a specific color and not
yet reporting the problem.

¢ Use different paper. You'd be amazed
how much better print quality is on
paper designed for photo printing.

¢ Make sure your paper is loaded correctly
to print on the printable side. It's usually
whiter or glossier than the other side.

¢ Make sure you select the appropriate
settings in the Print dialog for your
printer to use high-quality mode.

¢ CMYK files, which you can create in
some programs (but won’'t come from a
standard digital camera), may not print
correctly. Try converting them to RGB.

¢ Verify that the problems aren’t inherent
to the original image. If so, you may have
to edit the image to correct the issue.
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Print and Book
Problems and Solutions

A few common problems have cropped up
when working with prints and books.

Can’t Enable 1-Click Ordering

Early on, some people had trouble enabling
1-Click ordering within iPhoto, even though
they had a 1-Click account with Apple that
worked on Apple’s Web sites. To fix the prob-
lem, try one of these solutions:

¢ Connecttohttp://store.apple.com/,
click the Account link, and log in to your
Apple Store account. Click the "Change
Account Information” link, log in again
if necessary, and then change your pass-
word (changing other data wouldn't hurt
either). The goal here is to force the Apple
database to update so you can connect to
it via iPhoto. (If changing your account on
the Apple Store doesn’t have the desired
effect, try running through the same pro-
cedure at http://myinfo.apple.com/.)

¢+ Follow the above procedure, but
instead of clicking “Change Account
Information,” click “Change 1-Click
Settings.” Again, make some changes and
toggle 1-Click ordering off and on again
to see if that enables iPhoto to connect.

¢ If you can set up a new email address
easily, create it and then add a new Apple
ID that uses the new email address. This
should work, but isn’t an ideal solution,
since then you have to keep track of an
extra email address.

Errors During Ordering

You may encounter a few problems during
the process of ordering items from Apple:

¢ [fyou see an error dialog complaining
that a network connection could not
be established, verify that your Internet
connection is working by loading a page
in a Web browser or by checking your
email.

¢ You may see a confusing error message
that says, “The changes to your account
information could not be saved.” Ignore
the message, and enter your credit card
information again, making sure the card
hasn't expired. If that doesn’t work, try a
different credit card.

¢ Ifyou see an alert that your password
is invalid, but it works fine in the Apple
Store, change your password to be less
than 30 characters. The Apple Store
allows 32-character 1-Click passwords,
whereas iPhoto allows only 30-character
1-Click passwords.

¢ Different aspects of iPhoto may request
access to your password keychain
during ordering. That’s totally fine.

¢ [fyou have a firewall that blocks port 80,
try turning your firewall off, or allowing
data to pass through on port 80, to solve
upload errors.

¢ For the latest tips from Apple, see
www.apple.com/support/photoservices/
account_troubleshooting/. (You must
log in to see this page.)
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PRINT AND BOOK PROBLEMS AND SOLUTIONS

Chapter 11

Photos Don’t Upload

Some people have had trouble upload-

ing photos to Apple’s servers to have them
printed or turned into a book or other item.
Here are a few things to try:

Apple Has Trouble
Processing Your Book or Photos
There are several problems that can prevent

Apple from printing photos you've uploaded,
the two most common of which are damaged

® Tryagain later. Many Internet problems files and files that contain a question mark in
come and go, so a second try an hour or the filename. You should receive email telling
a day later may succeed. you about the problem, but a few common
issues include:
¢ If possible, see if the problem occurs
when uploading to MobileMe as well. ¢ Ifaphotohasa? in the filename, it won't
If not, the problem may be limited to print. Export the photo, change the file-
the specific servers used for prints or name, re-import, and delete the original.
other printed items. ¢ Damaged photos may not print. To
¢ [f possible, verify that you can upload identify damaged photos, connect to
a large file using a different program. If Apple’s Web site at www.apple. com/
that fails, the problem is likely with your internetservices/yourorderstatus/,
Internet connection. If it works, the where you can look for missing or partial
problem is probably in iPhoto. thumbnails for the order in question.
Once you've identified the damaged
¢ IfiPhoto complains about an error files, try exporting them, opening them
while accessing your account informa- in another application, saving a copy
tion, make sure the date and time on of each, and re-importing the copies to
your computer are set properly in the eliminate the corruption.
Date & Time pane of System Preferences.
It's a good idea to select Set Date & Time ¢ Ifyou order a print of an image that
Automatically in that preference pane to indicates it may be subject to another
eliminate the problem in the short term. person’s copyright, Apple may put your
If your Mac is several years old and loses order on hold pending verification that
track of the date and time regularly, you you have the right to make a copy of the
need to buy it a new clock battery. Macs photo. You must complete and submit
with dead clock batteries can suffer all an iPhoto Print Consent form; Apple
sorts of weird problems. will tell you how to do this when you're
contacted.
¢ Contact Apple via the Web forms
available from www. apple. com/support/ ¢ Using certain Type 1 PostScript fonts
photoservices/. can cause your book order to be can-
celled. For more information, see
http://support.apple.com/kb/TA22924.
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Troubleshooting

¢ If over half of the page numbers in a
book are hidden by photos, Apple may
cancel your order. It's easiest to deselect
the Show Page Numbers checkbox in
the Settings dialog before placing the
order, although you could also change

the theme or page design to one in which

phatos don’t cover the page numbers.

¢ Ifyoureceive email from Apple say-
ing your order can’t be processed, you
can wait for Apple to contact you with
details, or you can try to figure out what
went wrong, cancel the order, and then
resubmit it. Apple gives you up to 90
minutes to cancel the order yourself; do
this by logging in with your Apple ID
towww.apple.com/internetservices/
yourorderstatus/ and clicking the
Cancel Order link.

Order Doesn’t
Arrive or Is Damaged

There are several ways to learn more about

your order and to contact Apple if you expe-

rience problems with an order:

¢ Check the status of your order at
www.apple.com/internetservices/
yourorderstatus. You need your Apple
ID and password to sign in.

¢ Contact Apple via the Web forms avail-
able from www.apple.com/support/
photoservices/. Be sure to include the
text of your confirmation message from
Apple so they have your order details.

Prints or Books
Aren’t What You Expect

It’s highly frustrating to order prints or books
that aren’t of the quality you expect. Follow
these tips to avoid common problems:

# Prints ordered via iPhoto may come back
darker than is ideal. This may be because
Mac and PC monitors have different
color contrast settings, something called
gamma. Macs usually use a gamma of
1.8, whereas PCs use a darker gamma of
2.2. The belief is that Kodak serves more
PC customers and has thus tweaked its
equipment so PC users don’t think their
prints look washed out.

You can adjust your monitor to use

PC gamma settings when working with
photos. In the Color view of the Displays
pane in System Preferences, click the
Calibrate button to run the Display
Calibrator Assistant. Then work through
the Display Calibrator Assistant, picking
2.2 Television Gamma in the third screen.
When you're done, save the profile you
created, and select it in the Color view of
the Displays preference pane.

* Prints use a three-color process whereas
books use a four-color process. Because
black is added to photos in books, they
can appear slightly darker in books than
when ordered as prints.

¢ [fprints in your order from Apple are
garbled, the problem may be that the
photos were modified in another applica-
tion (like Photoshop) to use CMYK or
grayscale format. To fix the photos, use
another application to change the color
space to RGB, which Apple requires for
ordered prints and books.

¢ Tor the latest tips from Apple, see
www.apple.com/support/photoservices/
product_troubleshooting/.
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DEALING WITH WARNING ICONS

Chapter 11

Dealing with
Warning Icons

Let’s say you want to print a photo in a card,
calendar, or book, or via Apple’s online print
service, but iPhoto is displaying a warn-

ing icon on the page thumbnail or next to

a specific size you want in the Order Prints
window. What can you do to resolve this
situation?

Ways to handle warning icons:

¢ You can simply print at a smaller size.
When ordering prints, try a smaller size
(Figure 11.1); with a card, calendar, or
book, choose a different page design or
rearrange the photos so the offending one
prints at a smaller size (Figure 11.2). Or,
don’t zoom into the photo as far.

¢ Ifthe photo is too small because you
cropped it, you can select it, choose
Revert to Original from the Photos
menu, and crop it again to a larger size.
Irecommend this procedure primarily
if you think you're right on the edge of
receiving the warning icon.

® You can also increase the size of your
image using GraphicConverter or Adobe
Photoshop. The way these programs
scale the photo up might look better
than iPhoto’s method. though it's harder.

v Tips

W For exact details about how many pixels
photos must have to print at different
sizes, see “Preparing to Order Prints,” on
page 166.

B To learn how image resolution relates to
what comes out of a printer, take a look at
“Understanding Resolution,” starting on
page 204.
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Figure 11.1 Note how the three images showing here
have warning icons applied to different print sizes.
The first (heavily cropped) image can print well

only at wallet size. The second (slightly cropped)
won't print well at 8" x 10" or larger. The third image
(uncropped) drops out at 16" x 20".

Figure 11.2 Note how all these photos, which were
taken with my old QuickTake 100 at 640 x 480
pixels, show low-resolution warning icons in this
book layout, except the three smaller photos in the
upper left. A 640 x 480 image must be quite small to
print acceptably.
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Troubleshooting

Figure 11.3 Start with Apple’s iPhoto support pages for
general help and pointers to other resources.
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Figure 11.4 If all else fails, ask for help on Apple’s
iPhoto discussion boards.

Help Resources

I'm sure other problems and solutions will
become known after I finish writing. Along
with iPhoto’s online help (choose iPhoto Help
from the Help menu), a variety of Internet
resources provide assistance.

Places to look for more help:

¢ Check Apple’s iPhoto support pages
at www.apple.com/support/iphoto/
(Figure 11.3) and www. apple. com/
support/iphoto/customerservice/.

# Search in Apple’'s Knowledge Base using
the Search field on the pages listed above.
Narrow your search by adding terms, so
if you're having trouble importing RAW
files, search for “import RAW™ or some-
thing similar.

¢ Tryasking a question on Apple’s iPhoto
Web-based discussion forums linked at
http://discussions.info.apple.com/
(Figure 11.4). In my experience, these
discussions are good for straightforward
questions; harder questions may go
unanswered. When posting, state your
problem clearly and include relevant
information while at the same time keep-
ing the question concise.

¢ Fororder-related problems, contact
Apple via the Web forms available from
www.apple.com/support/photoservices/.
Make sure you have your order details at
hand.

¢ Check out TidBITS, the free weekly Web
site and newsletter [ publish. It contains
tons of useful information on all sorts
of topics, including digital photography.
Visit www. tidbits.com and search on
“iPhoto” or "photography” to see relevant
articles. You can also subscribe to receive
issues in email.
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DEEP BACKGROUND

Right off the bat, let me say that you don’t
need to read this appendix. It’s deep back-
ground, the kind of detail that you might
wish to delve into when you're attempting
to understand how iPhoto works, perhaps
because you've just printed a photo and
you're unhappy with the results.

The following pages contain “Understanding
Aspect Ratios,” “Understanding Resolution,”
and “Understanding Color Management.”
Each of these discussions examines an
aspect of digital photography from which
iPhoto, for the most part, tries to shield you.
That's great most of the time, but if you're
trying to understand how cropping removes
information from a photo, thus making it
print at a lower quality, you'll want to come
here for the explanation.

Lastly, although I've called this appendix
“Deep Background,” these topics are so
complex that entire books have been written
about each one. If these discussions leave
you with more questions, I'd encourage you
to visit a library or bookstore and browse
its collection of books on photography,
digital imaging, and prepress. I especially
recommend Real World Scanning and
Halftones, Third Edition, by David Blatner,
Conrad Chavez, Glenn Fleishman, and
Steve Roth.
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UNDERSTANDING ASPECT RATIOS

Appendix A

Understanding
Aspect Ratios

iPhoto makes it easy to select and crop a
portion of a photo using a specific aspect
ratio, but why is this important? It matters
because aspect ratios differ between
traditional and digital photos.

An aspect ratio is the ratio between the
width of the image and its height, generally
expressed with both numbers, as in the line
from Arlo Guthrie's song “Alice’s Restaurant
Massacree” about “T'wenty-seven, eight-by-
ten, color glossy photographs with circles
and arrows and a paragraph on the back

of each one.”

The aspect ratio of 35mm film is 4 x 6 (using
the standard print size rather than the least
common denominator of 2 x 3) because the
negative measures 24mm by 36mm. Thus,
traditional photographs are usually printed
at sizeslike 4" x 6", 5" x 7", or 8" x 10", all of
which are close enough to that 4 x 6 aspect
ratio so photos scale well. When there's a
mismatch between the aspect ratio of the
original negative and the final print, either
the image must be shrunk proportionally

to fit (producing unsightly borders) or some
portion of the image must be cropped. (The
alternative would be to resize the image
disproportionally, which makes people look
like theyre reflected in a funhouse mirror.)

The equivalent of film in digital photography
is the CCD (charge-coupled device), which
is essentially a grid of many light-sensitive
elements that gain a charge when exposed
to light. Through much digital wizardry,
the camera translates those charges into
the individual dots (called pixels) that, put
together, make up the image. Zoom in on a
picture all the way, and you can actually see
these pixels. So if your digital camera uses a
CCD that can capture a picture composed

Figure A.1 Thisis a 4 x 3 image witha 4 x6
landscape selection. A bit of the bottom of
the image would be lost, which is fine.

Figure A.2 Thisisa 4 x 3 image withas x7
landscape selection. Very little of the bottom
of the image would be lost to cropping.

Figure A.3 Thisis a 4 x 3 image withan 8 x 10
landscape selection. Losing the right side of
the image would be somewhat problematic.
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Figure A.4 Thisisa 4 x 3
portrait image witha 4 x 6
portrait selection. A bit on
the left would be lost, which
is fine (a better crop would
take some from the left, the
right, and the top).

Figure A.5 Thisis a 4 x 3 por-
trait image with a 5 x 7 por-
trait selection. A very small
amount on the left would be
lost, which is fine.

Figure A.6 Thisis a 4 x 3 por-
trait image with an 8 x 10 por-
trait selection. A better crop
would have cut off Tristan’s
feet, rather than coming so
close to the top of his head.

Figure A.7Thisisa 4 x3
portrait image with a square
selection. As you can tell, the
square selection is a lousy
choice for this image.

of 1600 pixels wide by 1200 pixels high, basic
math shows that your photos will have a
4 x 3 aspect ratio.

Why did digital camera manufacturers
choose a 4 x 3 aspect ratio when 4 x 6 is the
35mm film standard? It matches the aspect
ratios of early computer monitors. Early
common monitor resolutions were 640 x 480,
800 x 600, and 1024 x 768, all havinga 4 x 3
aspect ratio. Displaying a photo at full screen
size without cropping thus requires a4 x 3
aspect ratio. (And why did computer moni-
tors use a4 x 3 aspect ratio? Because that's
the aspect ratio used by televisions. However,
since HDTV uses a 16 x 9 aspect ratio, many
monitors now use that or 16 x 10.)

Hopefully the choices in iPhoto’s Constrain
pop-up menu make more sense now. If you're
starting from a photo with a 4 x 3 aspect
ratio, and you want a 20" x 30" print (a 4 x

6 aspect ratio), there’s no way to print that
photo without adding borders or cropping
because of the mismatch in aspect ratios.
The same applies to other standard print
sizes—they don’t match the 4 x 3 aspect ratio
of most digital photos. Rather than suffering
borders or automatic cropping, it's better to
crop the image yourself so you can be sure
the important parts are retained. Figure A.1
through Figure A.7 show how cropping a

4 x 3image at the other common aspect
ratios works for two sample images (results
will vary by image).

The 4 x 3 aspect ratio plays an important role
in output too, since iPhoto’s book designs
generally assume 4 x 3 images. The books
vary the final image size depending on

the page design, and you can zoom in and
re-center the image to crop temporarily, but
as long as the aspect ratio of your images
remains 4 x 3, the layout will work as Apple
intended. You can use different aspect ratios
in a book, but the layout may not work well.
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UNDERSTANDING RESOLUTION

Appendix A

Understanding Resolution

Understanding how the dimensions of a
digital photo relate to what comes out of

a printer is hard. That’s why iPhoto merely
alerts you with a warning icon when a photo
won't print well at a specific size. Read these
two pages to learn why iPhoto displays warn-
ing icons; “Dealing with Warning Icons,” on
page 177 offers help.

Pixels and Dots

Every digital photo is made up of a rectangu-
lar grid of points, called pixels, each of which
can display one of sixteen million colors or
several hundred shades of gray. For instance,
photos from one of my cameras are 3264
pixels wide by 2448 pixels high. Monitors also
display rectangular grids of pixels, say 1900
pixels wide by 1200 pixels high.

Not all of a 3264 x 2448 photo can fit on a
1900 x 1200 monitor when every pixel in the
image is mapped to a pixel on the monitor.
To display a photo so it fills a monitor, iPhoto
removes pixels on the fly, a process called
downsampling.

You can’t perform the same one-to-one
mapping when it comes to print, though,
because most printers (which have only four
or six colors) can't display a pixel’s exact
color in a single dot. Instead, they use collec-
tions of single-colored dots to fool the eye
into seeing that color. For this reason and
other more complex ones, the main fact to
grok is that, in general, the more pixels in
the image, the better it will look printed.

This fact is particularly relevant when you're
printing images at large sizes. For instance,
why does an image that looks fine when
printed at 4" x 6" appear fuzzy at 8" x 10"?

Imagine a knitted blanket. If you stretch it to
make it larger, you can see through the holes
between the strands of yarn. Expanding a

MG 2635 (100

Figure A.8 The original image at 100 percent.

8080 MG_Z635 1179 =

Figure A.g Shrink the image to 17 percent
of original size and the loss of detail caused
by downsampling makes it hard to see the
stripes on the penguin’s tie.

800 IMG_2635 (4008

Figure A.10 Expand the image to 400 percent
of the original and the fuzziness added by
interpolation becomes evident.
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Figure A2 Crop the image to 206 x 183 pixels and
you can see how the horse looks much fuzzier due
to all the interpolation necessary to expand it to the
desired size.

photo to print at a larger size works similarly,
except the printer fills in each hole with

dots of roughly the same color as the dots
surrounding the hole, a process called inter-
polation. The more pixels in the image, the
smaller the holes that need to be filled, and
the less interpolation is necessary.

Downsampling vs. Interpolation

Downsampling onscreen works well, since
it's easy to remove similarly colored pixels
without changing the image much. Even
though the photo loses pixels and thus
some detail, quality doesn’t suffer too much
(Figure A.8 and Figure A.9 on the previ-
ous page). Along with the fact that onscreen
images are extremely bright because moni-
tors emit light, whereas paper reflects light,
minimal downsampling helps explain why
photos look good on monitors at full size.

Interpolation, particularly on a printer, is
different. There’s no way to avoid adding
dots that didn’t exist before when expand-
ing a photo, and because those dots exist
only by virtue of the dots around them, they
make the image look fuzzier (Figure A.8
and Figure A.10 on the previous page).
Interpolation simply cannot add details to
the image that weren’t originally present.
Scale an image too large, and iPhoto warns
you that so much interpolation will be
needed that you won't like the result.

Cropping Implies Interpolation

Cropping exacerbates the problem because
it removes pixels, making the photo smaller
and requiring more interpolation to expand
the image back up to the desired size.

To see this, compare the original image in
Figure A.11 with Figure A.12, which shows
a heavily cropped version of the same image,
displayed at the same size as the original.
Notice how the cropped horse is fuzzier.
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UNDERSTANDING COLOR MANAGEMENT

Appendix A

Understanding
Color Management

iPhoto 5 first introduced tools for manually
adjusting color saturation, temperature, and
tint. Why did it take Apple so many versions
to add these tools? Color correction of any
sort is devilishly difficult to do right (and as
you may have noticed, even the automatic
Enhance tool gets it wrong at times). Color
correction suffers from two basic problems:
color is highly perceptual and different
devices render color in different ways.

Color Perception

Everyone sees color in different ways. My
wife and [, for instance, frequently disagree
on whether a given color is green or blue,
and the fact that my opinion generally seems
to match what others think as well doesn't
change her perception of 4 different color.
Plus, at least 10 percent of the population
suffers from some level of color blindness
that makes it impossible to perceive dif-
ferences between colors that others can
distinguish.

The conditions in which color is perceived
also make a huge difference, as you have
probably realized if you've ever purchased
a shirt in a store lit with fluorescent lights
and were surprised by how the shirt looked
when you tried it on at home under incan-
descent lights. Similarly, when painting a
room, you have to consider how the color
will look in sunlight during the day and with
artificial lighting at night. The differences
can be striking.

The lesson here is that you cannot define
color objectively—there is no right answer.
Always keep that in mind, and it will remove
some of the stress about achieving the
“perfect” color in your photos.

Rendering Color

Digital cameras, computer monitors, inkjet
printers, and commercial photo processing
equipment all use different methods of
rendering color. Even with monitors, there's
little common ground between CRT-based
monitors and LCD flat-panel monitors, and
sometimes even between LCD monitors
from different manufacturers.

When you take a picture with your camera,
look at it on your Mac, print a copy on your
printer, and order a large print of the image
from Kodak, you would like the colors in

the image to match closely at each step. The
engineers designing these devices have man-
aged to make the color produced by each one
match fairly well, but not perfectly. Here's
how it works.

Imagine a three-dimensional graph, with the
X-, Y-, and Z-axes representing the amount
of red, green, and blue in every possible color.
(Don’t worry about this turning technical;
that's as bad as it gets.) Now imagine an
amorphous blob in the graph that represents
the specific set of colors any given device can
capture (for digital cameras) or display (for
monitors or printers). That blob is called the
gamut, and every device has a gamut that’s
at least slightly different.

The problem with matching color across
completely different devices is that each
device can render only colors in its gamut.
When a color, say a specific dark blue, falls
into an area where there’s overlap between
gamuts, each device does the right thing and
renders the exact same dark blue. However,
when a color falls outside the set of colors a
device can render, it's a problem. The device
cannot render a color outside its gamut, so it
makes an educated guess about what color
to render instead.
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Color-Matching Systems

Many efforts have been made to address
this problem, but the one you're most likely
to have heard about, being a Mac user, is
Apple’s ColorSync technology. The particular
approach it uses to make educated guesses
about which colors to render on different
devices is immaterial; suffice to say that its
goal is consistency. In theory, if you have
chosen or set up a ColorSync profile for your
monitor and your printer, for instance, it
should help ensure that the colors you see
on your monitor match those printed by
your printer.

Without getting into too many details, you
can calibrate your monitor by choosing
System Preferences from the Apple menu,
clicking the Displays preference pane,
clicking the Color button, and clicking the
Calibrate button to run and work through
the Display Calibrator Assistant. Then, when
you're printing, look for a ColorSync setting
in the Color Management pane of the Print
dialog. Whether it’s present or not depends
on your printer driver, but if the setting is
present at all, it's usually the default. That's
all there is to basic use of ColorSync, and on
the whole, it works pretty well.

You may not be limited to ColorSync's
educated guesses about how to render
color (my Epson inkjet's Photo-Realistic
mode sometimes produces better results),
and in fact, none of the commercial photo
processing companies, including Kodak,
uses it. Why not? Two reasons.

First, photos are displayed on monitors and
on paper totally differently. Monitors emit
light, causing photos to be extremely bright.
Paper reflects light, so unless you shine a
floodlight on a photo, you can’t come close
to the amount of light emanating from a
monitor.

Second, as I noted, color is highly percep-
tual, and Kodak and other photography
companies have done incredible amounts of
research to determine not so much how to
match colors exactly, but how to print photo-
graphs that meet people’s expectations.

In the end, the problem of matching color
perfectly among devices is just too hard.
Even with technologies like ColorSync, the
differences between a photo on a light-
emitting monitor and light-reflecting paper
mean that the photo-processing companies
have a better chance of satisfying custom-
ers if they concentrate more on producing
a photograph that looks desirable than on
matching colors perfectly in an imperfect
world where everyone sees color differently.

Should You Correct Colors?

Color correction is complex, and the neces-
sary tools are also usually complex. Apple
did a good job with giving iPhoto basic color-
correction tools in the Adjust window, and
many photos can be improved with judicious
color correction. Of course, iPhoto’s tools are
still limited in comparison to those in pro-
grams like Adobe Photoshop: in particular,
iPhoto’s tools always affect the entire image,
rather than letting you select a portion of the
image to correct.

Now that you know how hard it is to achieve
reliable, predictable results, should you color
correct your photos using iPhoto or another
program? It depends on how much you want
to play. For those who don't like to fuss, don't
bother. If you like fiddling with your photos
so you can make them just right, go ahead.
And for the majority of us who fall between
those two poles, I recommend doing manual
color correction on those images you like the
most and that will benefit from it the most.
Remember, the “right” color is the one that
looks right to you.
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TAKING
BETTER PHOTOS

iPhoto and your digital camera will make
you a better photographer, for the simple
reason that the best way to improve a skill
is constant practice. Thanks to iPhoto, it’s
easier to take and review photographs than
ever before.

But you need not discover all the ways you
can take better photos on your own. Having
the best equipment for the kind of photos
you want to take will help, as will learning
some of the basics of different types of pho-
tography. This appendix offers that advice,
ranging from choosing the best camera

for your needs to tips on how to take great
pictures of kids. (Hint: The posed portrait is
unlikely to work.)

SOLOHd ¥3113g ONIIV]

So skim these few pages to find tips that you
can use to create better photos with minimal
extra effort.
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Appendix B

What Kind of
Photographer Are You?

When choosing the camera that will help
you take the best photos, it's important

to choose one that matches the kind of
photos you actually take. But what sort of
photographer are you? In one way of think-
ing, there are two types of photographers:
artistic and documentary (and as is usually
the case, most people overlap somewhat).

You’re an artistic photographer if:

¢ You care more about the overall look of
a photo than the subject of the picture
(Figure B.1).

¢ Objects and landscapes fill many of your
photos and stand alone as aesthetic rep-
resentations of your reality.

¢ Display and print quality is of the utmost
importance. You regularly print and dis-
play your best photos.

¢ You're willing to take time to set up the
perfect shot, and you do things because
they give you photo opportunities.

You’re a documentary photographer if:

¢ Who or what appears in the photo is
more important than the overall look
(Figure B.2).

¢ The most common subjects of your
photos are people and places, and they
usually fit into and support a larger story.

¢ You're willing to trade quality for conve-
nience, ease of use, or speed of shooting,

¢ Youdon't have the free time or patience
to set up shots, and you prefer to snap a
few pictures quickly, hoping that at least
one will turn out well. You carry your
camera to record events or in the hope
of getting a good shot.

[ il ¥ 8 Sl L

Figure B.1 There’s not much of a story in this photo—I
was just intrigued by the color of the leaf underneath
the new-fallen snow. We're definitely looking at an
artistic photograph here.

o =3
Figure B.2 In contrast, here we have a picture of
me and my grandmother at my 35th birthday party.
Whether or not it’s a good photo is almost imma-
terial—what’s important is that it reminds me of a
special meal with my family. It’s a pure documentary
photograph.
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Choosing a Camera

Once you've determined what sort of photog-
rapher you really are (and that may be differ-
ent from the type of photographer you'd like
to be in an ideal world), working through the
variables that differentiate digital cameras
becomes significantly easier.

Form Factor

Digital cameras come in a wide variety of
sizes, and for documentary photographers,
small size can be important so the camera
fits in a pocket and so the fact that youre
taking pictures doesn’t overwhelm the event.
In contrast, artistic photographers are often
willing to carry larger cameras because of
their increased quality and flexibility. Most
cameras fall in a middle ground, so it’s best
to hold the camera to see how it feels in your
hand before buying it.

Megapixels/Quality

Within the form factor that matches your
shooting style, you should usually try to get
the most megapixels (larger cameras have
larger CCDs and can thus capture more
pixels). But lens quality and other variables
make a difference too, and the best way to
learn about those issues is to read detailed
camera reviews, Artistic photographers need
to pay the most attention to quality issues.

Lens Capabilities

For documentary photographers, this mostly
comes down to whether or not the camera
has a decent optical (ignore digital) zoom

for capturing far away events. For artistic
photographers, zoom capabilities are impor-
tant for those times when you simply can’t
(or shouldn’t) get close enough to the subject
(such as a grizzly bear). Also important are
macro capabilities for stunning close-ups

of flowers, insects, and other small objects.

Extra Features

Extra features may be important: documen-
tary photographers may appreciate a movie
capability, whereas artistic photographers
might look for the capability to use an exter-
nal flash or different lenses. Also pay atten-
tion to factors like the camera’s battery type.
AA batteries are cheap and easily found, and
you can buy good rechargeable batteries, but
the smallest cameras generally have their
own battery packs and chargers.

Price

Everyone has a budget, and here’s where you
must decide how much to pay. Documentary
photographers will pay more for truly tiny
cameras with decent quality, whereas artistic
photographers pay more for quality, manual
controls, and support for additional lenses.
Although more money will buy a better
camera, you can take good pictures with
almost any camera.

Interface

Some cameras are easier to use than oth-

ers, which is important for documentary
photographers who need to be able to set
options quickly before missing a particular
shot. Artistic photographers care more about
control, so the camera interface should help
them twiddle manual settings easily.

Speed

Digital cameras can be quite slow, with a

few seconds to start up, a lag between when
you press the shutter release and when

the picture is taken, and a noticeable lag
between shots. Documentary photographers
in particular should look for faster cameras,
so0 as to avoid missing that perfect shot

due to camera lag. Artistic photographers
interested in action shots should also pay
attention to speed or risk losing great photos.
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Appendix B

Where to Read
Camera Reviews

After you've determined roughly what kind
of camera you want, you have a few choices.
You can go to a store and buy whatever the
salesperson recommends after hearing your
story. You can depend on a friend who has
already researched a similar type of cam-
era. Or you can do the research yourself. Be
forewarned—if you're not a camera buff, you
may find reading numerous camera reviews
overwhelming, thanks to the incredible
detail provided. I've found the sites below
useful for reviews, buyer’s guides, news,
discussions, and other digital photography
information.

Camera review sites:

* Digital Photography Review has an espe-
cially detailed feature search tool and a
useful way of comparing the specs on
different cameras, side-by-side.

Find it at: waw. dpreview. com

* Digital Camera Resource Page offers
an extensive camera database through
which you can search to find cameras
with your desired specifications. Reviews
are all on one page, making them easy to
read, unlike the other three sites.

Find it at: www. dcresource. com

* [maging Resource stands out from the
pack with its Comparometer, which lets
you compare sample photos taken with
different cameras. The site also offers an
easy-to-use model comparison tool.

Find it at: waw. imaging-resource.com

¢ Steve's DigiCams offers detailed reviews
and a nice summary page listing the
cameras the writers believe are the best
in each of a number of categories.

Find it at: waw. steves-digicams. com

A Better Starting Point

Honestly, camera reviews make me

crazy, since I don’t have a background

in traditional photography to help me
understand all the jargon. ['ve tried to lay
out the basics here, but if you want more
information about how to think about the
right camera for your needs and how to
understand the camera reviews, I recom-
mend Larry Chen’s Take Control of Buying
a Digital Camera, one of the Take Control
ebooks. Larry also provides advice on
evaluating image quality and gives you a
comparison worksheet to help you track
the different cameras you're considering.
Read more at www. takecontrolbooks.
com/buying-digicam.
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Camera Accessories

Although all you need to take good photos
is a camera, there are some accessories that
can help at times.

Bigger Memory Card

Most cameras ship with small memory
cards, and you may feel as though you should
shoot at a lower resolution to save space.
Don’t do it—just buy a larger memory card.
Visit www . dealram. com to compare prices

at multiple vendors for the type of memory
card your camera uses.

USB Card/PC Card Reader

If you have friends with digital cameras, a
USB or FireWire card reader that accepts

all the types of memory cards can make it
easy to share photos of an event on the spot,
without having to mail them around later.
Folks with laptop Macs might also look for a
PC Card or ExpressCard adapter that lets you
plug your memory card right into the laptop.

Alas, attachments to download photos into
an iPod have all faded away, but if you're
looking for a photo backup solution while
travelling, check out the Photo Safe IT or
Picture Porter Elite from Digital Foci. For
more info, visit waw.digitalfoci.com.

Monopod/Tripod

In low-light situations, if you don’t use the
flash, you risk your photos coming out blurry.
The solution? Attach the camera (most

have the appropriate threaded mount) to a
monoped or a tripod. Documentary pho-
tographers are less likely to want to use even
a monopod (which is smaller and faster to
use than a tripod) because of it getting in
the way, whereas artistic photographers are
more likely to accept a little extra annoyance
in exchange for the highest quality photos.
Either way, make sure it’s easy to use.

Extra Batteries

It's unfortunately common to run out of
power at a bad moment, particularly if you're
using your camera’s flash or LCD display a
lot. Avoid missing great photos because your
camera is dead by carrying an extra battery
pack or set of batteries. Proprietary battery
packs tend to be expensive, but my experi-
ence is that it's worth buying the camera
vendor's battery rather than one from an
independent manufacturer. Other cameras
take standard AA batteries; you can use any
normal battery, but it’s cheaper and more
environmentally friendly to use rechargeable
batteries, such as those available from Quest
Batteries; visit www. questbatteries.com.

Lens Cleaning Kit

Those of us who have used only digital
cameras may not realize that it’s well worth
getting a special lens cleaning kit that can
remove dust and dirt from your lens and
LCD (and for cameras with removable lenses,
the CCD inside). Normal cloth might cause
scratches. Any camera store should be able
to recommend a lens cleaning kit.

Printer

With iPhoto, you can always order prints
from Apple. But you may want to print them
yourself, perhaps for instant gratification,
greater control, or privacy reasons. For that
you'll need a color printer. There are a num-
ber of different technologies, such as inkjet,
laser, and dye-sublimation. Inkjet printers
are the most common, offer excellent qual-
ity, and come in a wide variety of sizes, but
have high per-print materials costs. Dye-
sublimation printers have the best quality
for photos, but can be expensive. And color
laser printers are the cheapest to run for
many prints, but may not have as good print
quality. You can learn more at camera review
sites, which also often review photo printers.
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GENERAL PHOTO TIPS

Appendix B

General Photo Tips

No matter what type of photos you take, a
few general tips will take you a long way:

¢ Consider the Rule of Thirds. Divide the
image into a 3 x 3 grid and try to position
the main subject of the photo where the
lines intersect (Figure B.3). If your photo
will have strong horizontal (as in a hori-
zon) or vertical lines (as in a building), try
to keep them on the horizontal or vertical
lines. Centering can work, but tends to be
a bit dull for anything but portraits.

¢ Pay attention to where the light comes
from and try to avoid shooting into
strong light. It’s better to shoot with light
at your back (make sure your subjects
aren’t squinting) or to one side whenever
possible. If you have to take a picture of
people who have the sun behind them,
turn on your flash to light up their faces,
which will otherwise be too dark.

¢ Don't be afraid to shoot from odd angles
or unusual heights. Digital cameras
encourage experimentation, and playing
around can produce some great shots.

¢ Avoid a busy background that will
distract the eye from the subject of the
photo (Figure B.4).

¢ Keep the camera steady, particularly
when you're shooting in low light without
the flash. The beauty of the LCD screen
on the camera is that you can set the
camera on a solid object to shoot, even
when it’s not at a comfortable height.

¢ Remember that the flash on most small
digital cameras works well only to about
10 feet. Relying on room light is tricky,
but the more light you can throw on the
subject in a normal room, the better.

Figure B.3 Note how the heads of Tristan and his
cousin Madeline are at the intersections of the grid,
increasing visual interest and emphasizing their
interaction.

Figure B.4 This photo shows the value of an unclut-
tered background—the blank wall helps the eye
focus on the man in the scene. Note too that the fact
that he’s only half in the frame increases the power of
the photo. Sometimes in photography, as in graphic
design, some “white space” can improve the image.
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More General Photo Tips

Here are a few more tips that can help:

¢ Try to match the orientation of the
subject to the orientation of the photo
(Figure B.5). Landscape orientation,
where the photo is wider than it is tall,
usually works best for landscapes (with
specific exceptions, such as the gorge in
Figure B.5), whereas portrait orienta-
tion, where the photo is taller than it is
wide, works best for people. Computers
and TVs generally use landscape orienta-
tion, so keep that in mind if you plan to
do a lot of slideshows.

¢ Try to avoid posing your subjects. Most
people aren’t very good at describing
exactly what they want the person in
the photo to do, and most people aren’t

Figure B.5 Portrait orientation makes all the differ- good at adopting a specific pose without
ence for this picture of the long, deep gorge that it looking forced. Give it a try and you'll
runs through Cornell University. appreciate how hard professional pho-
68 ST = tographers and models work.

¢ Figure out exactly what interests you
about a scene before shooting, That helps
you set up the shot and find different
ways of emphasizing the subject.

¢ Take lots of photos—they don’t cost any-
thing. This is especially important when
the scene is changing, but even with shots
you set up, it’s worth taking a few, just in
case one shot works better than another.

¢ As a corollary, try alternative ways of
taking a given picture, such as with and
without the flash. Do this enough and
you'll start to figure out when to use
certain settings for your desired effect.

¢ Don't be afraid to get close and fill the
frame with the subject, even when it
means cutting off parts of people’s bodies
or faces (Figure B.6).

Figure B.6 This close-up of my wife’s face works in
large part because it's so close and out of focus.
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Appendix B

Portrait Photo Tips S22 TGS

For many of us, pictures of people make up
the bulk of our photo collections. Use these
tips to improve your portraits of family and
friends in the future:

¢ Get closer. A lot of portraits are taken
from too far away, lessening the impact
of having that particular person in the
photo. Of course, since getting closer
isn't always feasible, a good zoom lens
can help.

¢ When you're taking pictures of traveling
companions, break the previous rule a bit
so you can add context to the shot. Signs
work well for reminding you of where and
when a picture was taken, particularly if
they're in other languages.

¢ For candid snapshots, which are often
the best kind, make sure you have enough
light and just point the camera in the S
right direction and shoot from the hip Figure B.7 | took this photo while holding the camera
(Figure B.7). Lots of these shots will be at my waist and walking normally down the street.
terrible, but the effort of tossing them is
well worth the occasional amazing shot
you'll get.

@00 WG_2110 (505

¢ Don’t warn people in advance that you're
going to take a photo unless you want
forced smiles. If you need people to look
at you, prefocus your camera by pressing
the shutter release button halfway, then
say something to get their attention. As
soon as they look at you, and before they
realize you're taking a picture, press the
button the rest of the way down.

¢ In group photos, make everyone crunch
together and overlap. The presentation is
much more interesting than if everyone

just lines up by height (Figure B.8). Figure B.8 This group photo from my family reunion
works well because the different levels provided by
the stairs help everyone overlap neatly.
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Child and Pet Photo Tips

People may be the most common subjects
of photos, but I'll bet most of those photos
are pictures of children. And those folks whao
don’t have children around often seem to
replace kid photos with pet photos. Children
and pets require similar shooting styles:

¢ Adults are usually capable of at least
that oh-so-familiar forced smile, but kids
often don't want to participate, and it's
almost impossible to convince pets to
pose. Give it up and shoot surreptitiously.

Figure B.g Getting a cat and a child both looking
photogenic at the same moment can be tricky unless
you're willing to take lots of shots. *

When kids or pets are playing, they may
O — T T — ‘ = not notice you, so work fast and take lots
o of pictures, perhaps with your camera’s
burst mode (Figure B.9). Try to avoid
calling out names, since that will almost
certainly break the spell.

# [fthe kids or pets realize what you're
doing, just be patient and stay prepared
in case you get another chance.

¢ Ifyou plan to take pictures of children,
encourage them to wear brightly colored
. _ clothing. Lots of color can make your
Figure B.10 The fact that the camera is on Tristan’s phOtos L eye_catChmg'
level, about a foot off the ground, provides a good .

pRFSHEEHN With both kids and pets, get down on

their level (Figure B.10). Otherwise you
end up shooting the tops of their heads.

¢ Atzoos or similar attractions, try to
photograph the child reacting to, or
interacting with, the animals.

¢ It can be great fun to involve kids in the
decisions about what pictures to take,
particularly if you're on a trip. Ask them
what they'd like you to take pictures of,
and let them set the scene (Figure B.11).

¢ Outdoor photos often work the best,
perhaps because it’s easier to get good,
uncluttered backgrounds.

Figure B.11 Since Tristan loved trains, these aban-

doned mine trains at the Last Chance Basin Mining
Museum in Juneau, Alaska, were a big hit. He asked
me to take this photo and even agreed to pose in it.
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Appendix B

Landscape Photo Tips

There are places where it seems almost
impossible to take a bad photo (glaciers and
mountain vistas, for instance), but a few tips
can help improve other landscape pictures:

¢ Take advantage of the long light early in
the morning (less haze) or just before
dusk (sunset colors), since you get
more interesting shadows and interplay
between light and dark. Try to keep the
sun at your back or your side.

¢ Try to keep the horizon level, although
iPhoto can straighten a photo if an
otherwise good photo is marred by a
bit of skew (Figure B.12).

4+ Keeping the Rule of Thirds in mind, if the
land is the subject of your photo, make
two-thirds of the photo be land, with
one-third sky. If the sky is the focus of
the photo (sunset photos can produce
the most amazing colors), then reverse
those proportions so the sky fills most of
the frame.

¢ Try toinclude an object in the foreground
to catch the eye, rather than leaving
the entire landscape in the far distance
(Figure B.13). A foreground object has
the added advantage of indicating the
magnitude of the scenery.

¢ When possible, eliminate distracting ele-
ments, such as telephone poles or electric
lines. Otherwise, try to use them in the
composition of the photo.

¢ Tryusing reflections in water or windows
for interesting effects and perspectives
(Figure B.14).

[ YY) [T (=)

Figure B.12 It’s hard to take a bad picture of a
glacier... unless you can’t hold the camera straight.
iPhoto’s Straighten tool can fix this shot.

Figure B.13 The misty woods in the background evoke
a mood, but Tristan running away from the camera
down the mown strip in the field lends focus.

Figure B.14 This picture, although seemingly a normal
landscape of trees and the sky, is actually a reflection
in a pond, giving the scene added depth.
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Figure B.15 Having Tristan pose in front of our cruise
ship, with its name visible in the background (though
hard to read at this size), made for a perfect travel
picture.

Figure B.16 Make sure to have other people take
pictures of you. You'll especially appreciate having
done this if you decide to make a book of your trip
in iPhoto.

Travel Photo Tips

Although the tips for landscapes and
portraits apply equally well when you're
traveling, a few special tips can help improve
your vacation photos:

*

Include your traveling companions in
the shots when possible, because with-
out them, you could just buy a postcard.

Take photos that remind you of an area
or event. Shoot details such as buildings,
signs, or natural landmarks, but take
them from your perspective and, when
possible, with your traveling companions
(Figure B.15).

Don'’t get sucked into the trap of posed
shots of your companions in front of
whatever the local attraction may be.
Have some fun and keep it light, partly
so you get better shots, and partly so
your traveling companions don't get sick
of your camera.

Ask one of your companions, or a passer-
by, to take pictures that include you.
Otherwise it may seem as though you
weren't along on the trip (Figure B.16).

Take pictures of the people you meet
(it's best to ask for permission first),
and make notes so you remember each
person later.

Plan ahead so you can take lots of pho-
tos. That may entail carrying an extra
memory card or two, bringing a recharge-
able digital wallet drive to store photos,
or lugging a laptop along (at which point
you can upload photos of your travel
photos for friends and family back home).
It's also worth doing a bit of culling every
night to free space used by bad shots.
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shadow detail adjustments, 104
sharpness adjustments, 105
temperature adjustments, 107
tint adjustments, 108
Advanced pane (Preferences window), 83
albums
creating, 39
deleting, 44
keywords vs., 54
removing photos from, 21, 47
selecting multiple, 45
smart, 40-41
sorting photos in, 48
See also Web albums
Appearance pane (Preferences window), 33, 35
Apple
1-Click ordering, 164, 165, 195
international shipping details, 167
ordering cards, calendars, and books, 185
ordering prints from, 166, 167, 196-197
pricing and shipping for orders, 185
Apple ID, 164, 165
Apple TV, 127, 134

applications
external editors, 110-111, 192
importing photos from other, 16
archiving photos, 27
artistic photography, 210
aspect ratios
book page designs and, 173
choosing for photos, 88
explained, 202-203
print sizes and, 166
selecting for slideshows, 120
assigning
keywords, 54
names to faces, 65
ratings, 52
titles, 49
Autoflow option, 172
autosplit feature, 37

backing up photos, 26, 27

basic slideshows, 114, 117

batch operations
date changes as, 51
rotating photos as, 86
title assignments as, 49

batteries, 211, 213

black point adjustments, 99

blog photos, 143

book slideshows, 114

books
adding, deleting, and moving pages in, 174
arranging photos on pages of, 175
aspect ratios of, 173, 203
autoflowing photos into, 172
creating, 172
designing pages for, 173
editing photos in, 176
entering/editing text in, 178, 179
font, style, and size settings, 180-182
maps added to, 78
ordering, 185
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books (continued)

printing, 184

quality issues with, 197

removing photos from, 47

troubleshooting orders for, 196-197
browsing

faces in Faces mode, 64

locations in Places mode, 72, 77
burning iPhoto discs, 26, 154
buying cameras, 211, 212

calendars
arranging photos on, 175
creating, 170
designing, 171
editing photos in, 176
font, style, and size settings, 180-181
ordering, 185
printing, 184
calibrating monitors, 197, 207
cameras. See digital cameras
card readers, 11, 14, 191, 213
See also memory cards
cards
creating, 168
designing, 169
editing photos in, 176
font, style, and size settings, 180-181
ordering, 185
printing, 184
CDs
burning iPhoto disc, 26, 154
checking readability of backups, 27
CD-R vs. CD-RW, 27, 28
importing photos from iPhoto, 17, 154
Kodak Photo/Picture, 14
checkmark keyword, 53
children, photos of, 217
clean installations, 6
Collage screen saver, 132
color
perception of, 206
rendering, 206
reproducing, 96
text, 182
color correction, 207
color management, 206-207
color-matching systems, 207
Colors window, 182
ColorSync technology, 207
comparing photos, 22
compression, 83
Confirm Name button, 64, 66
Constrain pop-up menu, 87
contact sheets, 163
contextual menu shortcuts, 34
Contrast slider (Adjust window), 100
corruption, 188, 192

crashes, 187, 189, 192

Crop button, 87

crop marks, 162

cropping
choosing aspect ratios before, 88
including extra space for, 89
interpolation implied by, 205
selecting area for, 87
steps in process of, 89

culling photos, 22

customizing slides, 122

D
Data folder, 19
date/time information, 51, 58

Definition slider (Adjust window), 102, 104, 105

deleting
albums, 44
book pages, 174
folders, 38
keywords, 53
originals from camera, 13
people from Faces, 70
photos, 21
saved slideshows, 116
sources, 44
‘Web albums, 44, 141
See also removing
Descriptions field, 50
deselecting photos, 45
designing
book pages, 173
calendar pages, 171
cards, 169
print projects, 159
Desktop & Screen Saver pane, 131, 132
Desktop photos, 131
digital cameras
accessories for, 213
aspect ratios in, 202-203
color rendering by, 206
considerations for choosing, 211, 212
ejecting from Desktop, 13
importing photos from, 13
launching iPhoto automatically, 12
reviews of, 212
unrecognized by iPhoto, 190
directory structure in iPhoto, 19
disappearing photos, 188
discussion forums, 199
Display Calibrator Assistant, 197, 207
display pane, 9, 32, 33
distributing slideshows, 127
documentary photography, 210
downsampling, 204, 205
dragging
exporting multiple files by, 153
importing photos by, 16
photos onto Albums list title, 39
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duplicating
folder and contents, 38
photos for editing, 85
sources, 42
duration of slides, 122, 124, 130
DVDs
burning iPhoto disc, 26, 154
slideshows on, 129-130

E

Edit Keywords window, 53
edit list, 79
edit mode, 8, 29, 80
Edit My Places dialog, 72
Edit Photos pop-up menu, 80, 110
editing, 79-112
Adjust window for, 96-108
aspect ratios and, 838
contrast, 100
cropping and, 89
date/time information, 51
definition/details, 102
duplicating photos for, 85
Effects window for, 94-95
enhancing photos, 91
exposure, 98
external editors for, 110-111
full screen mode for, 82
highlight detail, 103
histograms and, 97
layers used for, 112
levels, 99
noise, 106
nondestructive, 79
photos unavailable for, 192
print project photos, 176
RAW files, 83
reducing red-eye, 92
retouching photos, 93
rotating photos, 86, 123
saturation, 101
selecting part of photo for, 87
shadow detail, 104
shared photos, 151
sharpness of images, 105
slide photos, 123
smart albums, 40
straightening photos, 90
temperature of photo, 107
tint of photo, 108
tools for, 81-82
undoing changes from, 109
zooming photos for, 84
See also external editors
Effects window, 94-95
emailing photos, 156
Enhance button, 91
events
changing key photo, 36

making from flagged photos, 56

moving photos between, 37

renaming, 36

selecting after search, 57

splitting and mexrging, 37

viewing photos in, 36
Events pane (Preferences window), 33
EXIF (Exchangeable Image File) data, 15, 62
Export Photos dialog, 144, 152
exporting photos

dragging files for, 153

with keywords, 54

merging libraries and, 28

to QuickTime movies, 126

sharing via, 152-153

as slideshows, 126

to Web pages, 144-145
exposure adjustments, 98
Exposure slider (Adjust window), 98
Extended Photo Info window, 62
external editors, 110-111

editing photos in, 110

examples of, 111

RAW files and, 83

reasons to use, 111

selecting, 80

troubleshooting problems with, 192

F

Facebook
connecting iPhoto with, 136
creating albums on, 139
managing albums on, 141
sign up info for, 135
using names on, 68, 69

Faces mode, 8, 63-70
browsing, 64
deleting people from, 70
fixing mistaken faces in, 67
information added in, 68
limitations of, 63
naming faces in, 64, 65
organize mode and, 29, 30, 69
training, 64, 66

filenames
duplicate photo, 85
for exported files, 152
photo titles as, 28

files
exporting, 152-153
finding original, 19, 20
formats supported in iPhoto, 15
RAW, 2,83
sharing, 149

Finder window, 155

finding
camera reviews, 212
original files, 19, 20
See also searching
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Fit Slideshow to Music option, 120, 122
fitting photos to frames, 176
flagged photos, 56
Flickr
connecting iPhoto with, 137
creating albums on, 140
managing albums on, 141
sign up info for, 135
folders
creating, 38
deleting, 38, 44
directory structure for, 19
downloading photos to, 18
duplicating, 38, 42
moving items to/from, 38
smart albums and, 41
fonts
changing, 180-181
choosing, 169
copying information about, 181
Fonts window, 181
FTP, 142, 145
full screen mode, 82, 84

G

gamma, 197
gamut, 206
General pane (Preferences window), 33
edit mode preferences, 80
email configuration, 156
rotation direction preferences, 86
Geophoto, 71
geotagged photos, 71, 74, 140
GPS tracking, 71
GraphicConverter, 111, 152, 191, 198
greeting cards. See cards
Gutenprint/Gimp-Print drivers, 157

H

hardware requirements, 2
help resources, 199
hiding/showing
photos, 55
Thumbnail list, 81
hierarchical location browser, 72, 77
Highlights slider (Adjust window), 103
histograms, 97
Houdah Geo, 71

icons
orange flag, 56
orange X, 55
spinning progress, 141
warning, 167, 177, 198, 204
iDVD, 2, 129-130
iLife, 3,4
Image Capture, 18
iMovie slideshows, 128
import mode, 8, 12

Import Photos dialog, 15
importing photos, 13-18

from card readers, 14

from digital cameras, 13

entering import mode, 12

from files, 15

Image Capture used for, 18

from iPhoto discs, 17, 154

leaving originals in place when, 20
located in shared albums, 151

from Mail, Safari, and other apps, 16
by saving and dragging, 16
troubleshooting problems with, 190-191

Information pane

illustrated, 9, 31
viewing info in, 61, 62

Information dialog, 61
inkjet printers

color rendering by, 206
matching paper to, 160
printing tips for, 161

installing iPhoto, 4
interpolation, 205
iPhone, 127, 133
iPhoto

acquiring, 3

directory structure, 19

file formats supported in. 15
help resources, 199
installing, 4

interface, 9

launching, 7, 12

modes, 8

new iPhoto ‘09 features, 6
relaunching after crash, 187, 189
sharing photos in, 150
system requirements, 2
updating, 5-6

version numbers, 1

Web export tools, 145

iPhoto Buddy, 25

iPhoto discs, 17, 26, 154, 191

iPhoto Library Manager, 25, 28, 189
iPhoto Library packages, 19

creating multiple, 24

deleting items from, 19

importing without copying into, 20
merging, 28

opening, 19, 25

recovering photos from, 19
switching between, 25

See also libraries

iPod, 127, 133
IPTC metadata, 54
iTunes, 119

iWeb, 142-143

blog photo publishing with, 143
publishing photo pages with, 142
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buying larger, 213

removing from card reader, 14
unrecognized by iPhoto, 190
K merging

JPEG compression, 79, 83

Keepsakes list, 30 events, 37
Ken Burns Effect, 118, 122, 124, 128, 132 libraries, 28
key photos, 36, 68 metadata
keywords EXIF, 15,62
albums vs., 54 IPTC, 54
categorizing album photos with, 39 viewing, 62

exporting with photos, 54
included in Flickr uploads, 140
on iPhoto discs, 17
removing from photos, 54
searching photos by, 59
working with, 53-54 managing albums on, 141
Kodak Photo/Picture CDs, 14 sign up info for, 135
L subscribing to albums on, 146

landscape orientation, 130, 131,215 Modified folder, 19
landscape photo tips, 218 monitors

laptop memory card adapters, 14 aspect ratios of, 203
Last Import album, 12 calibrating, 197, 207

launching iPhoto, 7, 12 color rendering by, 206
layers, 112 light emitted by, 205, 207

lenses, 211,213 using dual, 125, 131
Levels histogram, 97 Mosaic screen saver, 132
Levels sliders (Adjust window), 99 moving
libraries book pages, 174 )
creating multiple, 24 items into and out of folders, 38

iPhoto Library folders, 26 pf}otosvbet\,\.reen events, 37
merging, 28 multiple libraries, 24

rebuilding, 188, 189 multiple photos
sharing, 148-149 date changes for, 51
switching between, 25 descriptions assigned to, 50
See also iPhoto Library packages hiding/showing, 55
lighting adjustments, 107 titles assigned to, 49
lossy vs. lossless compression, 83 multiple prints, 163

low-resolution warning icon, 177, 198, 204 music ) _
M choosing for slideshows, 117, 119, 130

fitting slideshow to, 120, 122
troubleshooting problems with, 193

Mirror Image option, 174
misnamed files, 191
MobileMe
creating albums on, 138
iWeb uploads via, 142

Mail messages, 16

X3an|

Mail Photo dialog, 156

N

managing photos ) _
archiving photos, 27 naming/renaming
backing up photos, 26-27 events, 36
creating multiple libraries, 24 exported files, 152
culling imported photos, 22 faces, 64, 65
deleting photos, 21 keywords, 53

iPhoto directory structure for, 19
leaving imported photos in place, 20
recovering photos, 23

maps

travel book, 78
viewing, 72, 73, 76
working with, 76
zooming, 73, 76

megapixels, 211
memory cards

source items, 43
network photo sharing, 149
noise reduction, 106
nondestructive editing, 79

o

Open dialog, 80

orange flag icon, 56

orange X icon, 55

Order Prints dialog, 167, 198
Order window, 185
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ordering
1-Click, 164, 165, 195
Apple ID for, 164, 165
books, 185, 196-197
cards and calendars, 185
getting help with, 199
pricing/shipping details for, 185
prints, 166-167, 196-197

troubleshooling issues with, 195-197

organize mode, 8
controls available in, 31
new features in, 29, 30
switching to, 29

organizing photos, 29-62
adding photos to sources, 46
albums used for, 39-41
contextual menu shortcuts, 34
deleting sources, 44
descriptions for, 50
display pane for, 32, 33
duplicating sources, 42
editing photo dates, 51
events for, 36-37
flagging photos, 56
folders for, 38
hiding/showing photos, 55
keywords used for, 53-54
navigating in iPhoto, 35
ratings used for, 52
removing photos from sources, 47

renaming and rearranging sources, 43

selecting photos, 45

smart albums for, 40-41

sorting photos, 48

splitting/merging events, 37

titling photos, 49

viewing photo information, 61-62
Originals folder, 19

P
paper
choosing size of, 162
light reflected by, 205, 207
matching print settings to, 160
prints appearing incorrectly on, 194
selecting type of, 161
Paper Size pop-up menu, 162
passwords
Apple 1D, 164, 165
forgotten, 165
MobileMe, 138
photo sharing, 150
strong, 164
perception of color, 206

performance problems, troubleshooting, 188

permissions, 190
pet photos, 217
photo feeds, 146

Photo/Picture CDs, 14
Photocastr, 146
photos
aspect ratios, 88
backing up, 26, 27
dates of, 51
deleting, 21
descriptions for, 50
Desktop, 131
disappearing, 188
duplicating, 85
editing, 79-112, 123
emailing, 156
enhancing, 91
exporting to Web pages, 144-145
flagging, 56
geotagging, 71, 74
hiding/showing, 55
importing, 13-18, 191
information about, 61-62
keywords for, 53-54
moving between events, 37
noise reduction, 106
orientation of, 215
publishing, 138-142
rating, 52
recovering, 7, 23, 191
removing from sources, 47
retouching, 93
rotating, 86, 123
screen saver, 132, 134
searching for, 57-60
selecting, 45
sharing, 147-156
sharpness of, 105
slideshows of, 113-134
sorting, 48
straightening, 90
temperature of, 107
tint of, 108
titling, 49
undoing changes to, 109
zooming, 84, 123, 176
Photos Per Page pop-up menu, 162
Photoshop Elements, 111
picture books, 42
Pictures folder, 19
Pixelmator, 111
pixels, 202
aspect ratios and, 166
removed when cropping, 89
resolution and, 204-205
Places mode, 8, 71-78
adding new places in, 75
browsing locations in, 72, 77
geotagging photos in, 74
mapping locations in, 72, 76
organize mode and, 29, 30
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travel book feature, 78

viewing maps in, 72, 73
playlists for slideshows, 119
plug-ins, 6, 144, 145
portrait orientation, 130, 131, 215
portrait photo tips, 216
postcards. See cards
Preferences window

Advanced pane, 83

edit mode setting, 80

email configuration, 156

external editor setting, 110

General, Appearance, and Events panes, 33

rotation direction setting, 86
Web pane, 137

previewing
photos on memory cards, 14
prints, 160, 184
slideshows, 130

Print dialog, 158, 184

printers
color rendering by, 206
drivers for, 157
selecting for photo printing, 213
testing output of, 160
tips for inkjet, 161

printing
books, 184
calendars, 184
cards, 184
contact sheets, 163
designing projects for, 159
overview of features for, 157
paper selection for, 161
preparing photos for, 166
previewing prints for, 160
quality problems with, 194
selected pages, 184
standard-size prints, 162
steps in process of, 158
tips for, 161
troubleshooting, 194

prints
ordering, 166, 167
previewing, 160
quality issues with, 197
sizes and aspect ratios for, 166

publishing photos
to Facebook, 139
to Flickr, 140
to iWeb, 142-143
to Mobile Me, 138

Q

QuickTime movies
distributing, 127

exporting photos and slideshows to, 126

Windows error when playing, 193

R

ratings
assigning, 52
searching by, 60
smart albums and, 40, 41
RAW files
editing, 83
facts about working with, 83, 193
formats supported for, 2
rearranging
book pages, 174
source items, 43
rebuilding libraries, 188, 189
recovering photos
during upgrade, 7
original photos, 109, 191
from Trash, 23
red-eye reduction, 92
Reduce Noise slider (Adjust window), 105, 106
reinstalling iPhoto, 189
removing
album photos, 21
keywords from photos, 54
slideshow photos, 47, 121
smart album photos, 41
Web album photos, 141
See also deleting
renaming. See naming/renaming
rendering color, 206
resolution
cropped photos and, 89
explained, 204-205
warning icon, 177, 198, 204
restoring photos
from iPhoto disc, 17
from Trash, 23
retouching photos, 93
Revert to Original command, 109, 110, 192
rotating photos, 86, 123
RSS feeds, 146
Rule of Thirds, 214, 218

S

Safari, 16
Saturation slider (Adjust window), 101
saved slideshows, 114
controlling, 125
creating and deleting, 116
customizing slides in, 122
distributing, 127
duration of slides in, 122, 124, 130
DVD slideshows from, 129-130
editing photos in, 123
exporting, 126
iMovie slideshows from, 128
Ken Burns Effect for, 124, 128, 132
manipulating, 121
music for, 117,119, 130
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saved slideshows (continued)
running, 125
See also slideshows
Scale Photos to Fill Screen option, 125
screen savers, 132, 134
scrolling behavior, 35
scrubbing, 36
searching, 57-60
by date, 58
by keywords, 59
by rating, 60
selecting
pages for printing, 184
parts of photos, 87
photos and albums, 45
Set Up Account dialog, 164, 165

Shadows slider (Adjust window), 103, 104, 105

Shared folder, 148
shared volumes, 149
Sharing pane (Preferences window), 150
sharing photos, 147-156
accessing shared photos, 151
actions allowed for, 151
burning iPhoto disc for, 154
discs for non-iPhoto users, 155
emailing photos, 156
exporting files for, 152-153
iPhoto Sharing for, 150
library sharing for, 148-149
network photo sharing for, 149
shared volumes for, 149
troubleshooting problems with, 189
turning on/off, 28, 150
sharing tools, 32
Sharpness slider (Adjust window), 105
shipping information, 165, 167, 185
shortcuts
contextual menu, 34
keyword, 53, 54
size
aspect ratios and, 166
paper, 162
text, 180-181
Size pop-up menu, 152
Size slider, 9, 31
slideshow mode, 8

Slideshow Settings window, 117, 120, 122

slideshows, 113-134
adding photos to, 121
Apple TV, 134
arranging photos in, 121
controls for, 125
creating, 116
default settings for, 120
deleting, 116
Desktop photo, 131
distributing, 127
DVD, 129-130

exporting, 126

iMovie, 128

iPod or iPhone, 127, 133

music for, 117, 119, 130

removing photos from, 47, 121

running, 125

screen saver, 132, 134

setting up basic, 117

syncing, 127, 133-134

themes for, 117, 118

tips for, 125

tools for, 115

troubleshooting, 193

types of, 114

See also saved slideshows
smart albums

creating and editing, 40

ideas for working with, 41

removing photos from, 21

sorting photos in, 48
software requirements, 2
Software Update, 5, 187, 190
sorting

photos, 48

slideshows, 121
source parne

deleting items from, 44

dragging photos into, 15, 39

duplicating sources on, 42

illustrated, 9, 31

resizing, 31

saved slideshows in, 115

switching to organize mode in, 29
sources, 30

adding photos to, 46

deleting, 44

duplicating, 42

removing photos from, 47

renaming and rearranging, 43
Speech submenu, 183
spelling tools, 50, 183
spinning progress icon, 141
splitting events, 37
standard-size prints, 162
straightening photos, 90
strong passwords, 164
styles

copying info about, 181

screen saver, 132

text, 180-181
subscribing to Web photo feeds, 146
switching between libraries, 25
synchronizing

slideshows, 127, 133

Web albums, 141

T

taking better photos, 209-219
artistic vs. documentary photos, 210
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camera accessories for, 213
children and pets, 217
choosing a camera for, 211
finding camera reviews for, 212
general tips for, 214-215
landscapes, 218
portraits, 216
travel photos, 219
television slideshows, 125, 127, 134
Temperature slider (Adjust window), 107
testing printer output, 160
text
changing color of, 182
checking spelling of, 50, 183
copying font and style info, 181
entering/editing, 178, 179
font, style, and size settings, 180-181
rules for typing, 179
warning icons, 177
themes
book, 172,173
calendar, 170, 171
card, 168, 169
contact sheet, 163
print project, 159
slideshow, 117, 118
thumbnails
corrupted, 192
hiding/showing list of, 81
slideshow, 115
TidBITS, 199
TIFF files, 83
time/date information, 51, 58
Tint slider (Adjust window), 108
titles
for photos, 49
for slideshows, 118, 128
tools
editing, 81-82
slideshow, 115
Web export, 145
transitions for slideshows, 120, 193
Trash album, 21, 23
travel photos
maps for, 78
tips for taking, 219
troubleshooting, 187-199
book or photo processing, 196-197
disappearing photos, 188
editing problems, 192
external program issues, 192
help resources for, 199
import problems, 190-191
iPhoto crashes, 187, 189
ordering issues, 195-197
performance problems, 188
photo upload problems, 196
printing, 194

RAW files, 193
slideshows, 193
unrecognized cameras/card readers, 190
warning icons, 198
Type 1 PostScript fonts, 180, 196

U

undoing

deleted book pages, 174

editing changes, 109
unflagging photos, 56
updating iPhoto, 5-6
upgrading iPhoto Library, 7
uploading

iWeb choices for, 142

photos for print orders, 167, 196
user names

Apple ID, 164, 165

MobileMe, 138

'

Verify Burned Data option, 27
viewing

event photos, 36

maps, 72, 73, 76

photo information, 61-62
Voiceover window, 128

w

warning icons
low-resolution, 177, 198, 204
ways of handling, 198
Web albums
adding photos to, 141
deleting, 44, 141
export tools for, 145
Facebook, 135, 136, 139
Flickr, 135,137, 140
iWeb, 142
MobileMe, 135, 138
removing photos from, 47, 141
subscribing to, 146
synchronizing, 141
Web pane (Preferences window), 137
Web sites
camera review, 212
distributing slideshows on, 127
exporting photos to, 144-145
white point adjustments, 99
Windows computers
burning discs for users of, 155
error playing QuickTime movies on, 193

Y

YouSendIt plug-in, 156
YouTube, 127

Z

zooming
maps, 73, 76
photos, 84,123, 176
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